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Q1. Printek India has five workstations and two printers. This is most
likely a: प्रिंटेक इडिया में पांच वर्क स्टेसशन और दो प्रिंटर है। यह निम्न  में से लगभग
किस के  समान है।

*
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Ctrl + J

Alt + J

Ctrl + Alt + J

Shift + J
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By pressing Esc

By clicking the left mouse button

By pressing F12

By pressing Teb

1/1

The amount of RAM in every computer

1 billion bytes

1024 KB

1000 bytes

Q2. Which of the following key combinations is used to justify a
paragraph in MS Word 2016? MS WORD 2016 में वर्तनी की जांच करने के  लिए
निम्नलिखित में से किस शॉर्टकट कुं जी का उपयोग किया जाता है ।

*

Q3. How do you navigate from one side to another in a slide show?
स्लाइड शो मे आप एक स्लाइड से दू सरी स्लाइड पर कै से जाते है।

*

Q4.  1 MB is equal to ………..  एक एमबी (MB) _______के  बराबर होता है । *
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Caps Lock

Num Lock

Scroll Lock

Ctrl

1/1

Mouse search

Index search

Directory search

Keyword search

1/1

Param

Aryabhatta

Buddha

RAM

Q5. Which of the following keys is NOT a toggle key? निम्नलिखित कुं जियों में
से कौन सी टॉगल कुं जी नही है।

*

Q6. A  Search Engine provides various search approaches, EXCEPT: खोज
इंजन निम्न में से किस एक को छोड विभिन्न खोज दृष्टिकोण प्रदान करता है ।

*

Q7. The first super computer developed in India was: भारत में विकसित
पहला सुपर कं प्यूटर निम्न में से कौन सा है ।

*
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Input

Output

Software

Storage

1/1

Line spacing

Text spacing

Margin change

Searching

1/1

Ctrl + B

Alt + B

File/Format/Bold

Shift + B

Q8. What type of device is a 3-1/2 inch floppy drive? 3 ½ इंच की फ्लॉपी
ड्रा इव प्रकार की डिवाइस है।

*

Q9. Which of the following is NOT related to text formatting ? निम्न में से
कौन सा टेक्ट्र  फार्मेटिंग से संबंधित नहीं  है।

*

Q10. Which keyboard shortcut bold selected text? कौन सा कीबोर्ड शॉर्टकट
चयनित टेक्स्ट‍ को बोल्ड करता है ।

*
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Replace

Find

Lookup

Search

1/1

Increase font size

Insert a line break

Applies bold format to selected text

Applies italic format to selected text

1/1

Ctrl + S

Ctrl + P

Ctrl +O

Ctrl + N

Q11. The quickest and easiest way in MS Word 2016  to locate a
particular word or phrase in a document is to use the command: MS
WORD 2016  में किसी दस्तावेज में किसी विशेष शब्द या वाक्यांश का पता लगाने के
लिए सबसे तेज और आसान तरीका कौन सी कं माड का उपयोग करना है।

*

Q12. The keystroke Ctrl + I is used to : कीस्ट्रो  क Ctrl + 1 का उपयोग किस के
लिये किया जाता है ।

*

Q13. Which shortcut key is used in MS Word to open a new blank
document? नया खाली दस्तारवेज खोलने के  लिए  MS WORD में से कौन सी शॉर्टकट
कुं जी का उपयोग किया जाता है ।

*
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File

Tools

View

Insert

1/1

Workforce

Workbook

Worktables

Workgroups

1/1

CPU

Router

Modem

Hub

Q14. In MS PowerPoint, chart option is found under which tab ? MS
PowerPoint में, चार्ट विकल्प किस टैब के  अंतर्गत पाया जाता है ।

*

Q15. MS  Excel documents are stored as files called: MS Excel दस्तावेज को
जिस फाइल रूप में संग्रहीत किया जाता है  उसे क्या कहते है।

*

Q16. IP address of a packet is normally analysed by: पाके ट का IP एड्रे स
सामान्यंत: किसके  द्वारा विश्लेषित किया जाता है ।

*



1/1

A computer virus

A browser

A Program that indexes web sites

A hacker community that hacks web sites

1/1

Tracks

Sectors

Tracks and sectors

Heads and sectors

1/1

Internal Messaging

Instant messaging

Instant Marketing

Internet Marks

Q17. What is a web crawler? वेब क्रॉलर क्या है। *

Q18. A floppy disk is organized as: फ्लॉपी डिस्क्  को किस रूप में व्यूवस्थित
किया जाता है ।

*

Q19. IM stands for………. IM का पूर्ण रूप क्या है । *
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Function

Special purpose

General purpose

Navigation
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Pixel

Thermal printer

Voice-over IP (VoiP)

Web camera

1/1

B2:B9

B$2:B$9

$B$2:$B$9

$B2:$B9

Q20. The keyboard keys that have arrows on them are called ……….keys.
कीबोर्ड कीज जिन पर एरो होते है, उन को क्या कहा जाता है ।

*

Q21. Smallest on the screen that can be turned ON and OFF to make
different shaded of individual dots that forms  images on the monitor is
known as: स्क्रीन पर सबसे छोटी यूनिट जोकि व्यतक्तिगत डॉट्स के  विभिन्ना रंगो को
बनाने के  लिए चालू और बंद किए जा सकते है जो मॉनिटर पर बनाते है, वे किस नाम से
जाने जाते है ।

*

Q22. In MS Excel , to change the cell reference B2:B9 to an absolute row
and column reference, you would enter it as : MS Excel में सेल रेफरेंस B2:
B9 को एक एब्सो् ल्यूटरो और कॉलम रेफरेंस में बदलने के  लिए, आप इसे प्रविष्टम करेंगे ।

*
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Ctrl

Del

Entre

Num Lock

1/1

Wiki

Broadcast

Vodcast

Podcast

1/1

Soft Copy

Zerox

Internet Copy

Hard Copy

Q23. Which of the following keys is NOT on the number keypad? नंबर
कीपैड पर इनमें से कौन सी कुं जी नही ।

*

Q24. A program, either talk or music, available in digital format for
automatic download over the internet is called: एक प्रोग्राम, वार्तालाप अथवा
संगीत, जो इंटरनेट पर स्वूचालित डाउनलोड के  लिये डिजिटल प्रारूप में उपलब्धं हो, उसे
क्या, कहते है ।

*

Q25. The printed report by a computer is called : कं प्यूपटर द्वारा मुद्रित रिपोर्ट
को क्या जाता है ।

*



1/1

Ctrl + I

Ctrl +N

Ctrl+ N

Ctrl + T
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Address decoding

Bus contention

Bus collision

Address multiplexing

1/1

Boot no

Boot code

Boot sequence

Boot

Q26. Which key combination can be used to open Insert tab in MS Excel?
MS Excel में इन्सार्ट टैब खोलने के  लिए निम्नज में से कौन सी कुं जी संयोजन का उपयोग
किया जा सकता है ।

*

Q27. The condition when two or more derives tries to write data to bus
simultaneously is called …….. वह स्थिति, जब दो या दो से अधिक डिवाइस एक साथ
बस में डेटा लिखने का प्रयास करते है तो उसे ....... जाता है ।

*

Q28. Which options is used to change the boot device in BIOS setup?
BIOS सेटअप में बूट डिवाइस को बदलने के  लिए किस विकल्प का उपयोग किया जाता
है ।

*



1/1

FTP

TFTP

SMTP

TCP

1/1

LAN card

Sound card

Modem

Video card

1/1

Boot sector

Metamorphic

Parasitic

Memory resident

Q29. Which transport protocol is used by Telnet?  टेलनेट द्वारा किस परिवहन
प्रोटोकॉल का उपयोग किया जाता है।

*

Q30. ………..is a device that converts digital data to analog signal and vice
versa.  वह कौन सा डिवाइस है जो डिजिटल डेटा को एनालॉग सिग्नाल और इसके
विपरीत में बदलता है।

*

Q31. Which virus itself completely at each iteration, increasing the
difficulty of detection ? कौन सा वायरस प्रत्ये क पुनराव्रत्ति पर, अपने आपको पूरी
तरह से लिखता है जिससे पता करने में कठिनाई पढ जाती है ।

*
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Access control list

Access control entity

Discretionary control list

System access control list

1/1

Add port

Link port

New port

Create port

1/1

Init

Kernel

GRUB

MBR

Q32. specifies a list of user and groups who have permission on the
object. ........ उन उपयोगकर्ताओं और समूहों की एक सूची निर्दिष्ट करता है जिनके  पास
ऑब्जेाक्टस पर अनुमति है ।

*

Q33. Which button in the port tab is used to redirect port tabs to another
printer ? पोर्ट टैब में कौन सा बटन, पोर्ट टैब को किसी प्रिंटर पर रीडायरेक्टे करने के
लिए उपयोग किया जाता है ।

*

Q34. In LINUX, which process executes run level programs while booting
? लीनक्स में बूटिंग के  दौरान कौन सा प्रोसेस रनलेवल प्रोग्राम्स को क्रियान्वित करता है ।

*
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asx

arf

arfw

asrf

1/1

Bt.img

bmp

wbmp

wbpm
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Shift+M

Alt+M

Ctrl+M

Alt+W

Q35. Which file format is used to save Web Ex advanced record ?  Web Ex
एडवांस्ड रिकॉर्ड को सहेजने के  लिए कौन से फाइल फॉर्मेट का उपयोग किया जाता है ।

*

Q36. Which file format is used to save Standerd Windows bitmap image ?
Standard Windows bitmap image को सहेजने के  लिए कौन से फाइल फॉर्मेट का
उपयोग किया जाता है ।

*

Q37. What is the key combination to open Mailings tab ?  मेलिंग्स टैब को
खोलने के  लिए कुं जी संयोजन क्या है ।

*
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File>Send

Insert

View

File>Reload
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FALSE

TRUE

0

1

1/1

Flatbed plotter

Electrostatic plotter

Inkjet plotter

Micro grip plotter

Q38. By using which option can you create an HTML document in Open
Office Writer ? किस विकल्प् का उपयोग करके  आप Open office Writter में एक
HTML दस्तावेज बना सकते है।

*

Q39. Cell C2 contains TRUE ; C5 contains FALSE. What will be the output
for the function ISLOGICAL (C5) in an Open Office Calc ? सेल c2 में है TRUE;
C5 में है FALSE , Open office calc में फं क्शन ISLOGICAL (C5) का क्या आउपुट
होगा।

*

Q40. Pinch wheels are used by which type of plotter ? पिंच वही‍ल्ज का
उपयोग किस प्रकार के  प्लॉटर द्वारा किया जाता है ।

*
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Luminance

Information regarding the colour

Brightness

Resolution

1/1

8

2

4

16

1/1

Audio

Video

Data

Personal

Q41. In YUV colour representation model, U and V represents the: YUB रंग
प्रतिनिधित्व मॉडल में U और V किस का प्रतिनिधत्वक  करते है ।

*

Q42. The octal number system has the base as; अष्ट क संख्यान प्रणाली का
आधार ..........है।

*

Q43. conferencing enables participants at two or more sites to have
shared workspace on their computer desktops. .............कॉन्फ्रें  सिग
प्रतिभागियों को दो या दो से अधिक साइटो पर उनके  कम्प्यूटर डेस्क(टॉप पर वर्क स्पेस
करने के  लिए सक्षम बनाता है ।

*
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Randomised

Asynchronous

Time interval

Sequential
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Interpreter

Compiler

Assembler

High level language

1/1

Editing

Decoding

Debugging

Rectifying

Q44. Which of the following is a type of transmission method used by
modem ? निम्न में से कौन सी संचरण विधि मॉडेम में इस्तेमाल की जाती है ।

*

Q45. translates and executes program at run time line by line. ..........रेखा
प्रति रेखा, रन टाईम पर प्रोग्राम का अनुवाद और निष्पादन करता है ।

*

Q46. Testing a program for any syntax or logical errors is known as :
वाक्यजविन्याास सिंटेक्स या तार्कि क त्रुटियो के  लिए किसी प्रोग्राम के  परीक्षण करने केा
किस नाम से जाना जाता है ।

*
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Public- everyone with Internet access can see it.

Internal- only people within the company can see it.

External- people outside the company can see it.

Shared – both primary employees and suppliers can see it.
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Bubble

Stock

Column

Radar

1/1

Conic

XY

Surface

Pie

Q47. What kind of website is the intranet ? इंट्रा नेट किस तरह की वेबसाइट है। *

Q48. chart can be used for illustrating comparisons among items in MS
Excel. MS Excel में वस्तुओं के  बीच तुलना को चित्रित करने के  लिए .......... चार्ट का
उपयोग किया जा सकता हे ।

*

Q49. chart displays the relationships between the numeric values in
various data series in MS Excel. …………चार्टMS Excel में विभिन्न डेटा श्रृखलाओं
में संख्यारत्मक मानेां के  बीच संबंध प्रदर्शित करता है।

*
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1-(iv), 2-(iii), 3-(ii),4-(i)

1-(ii),2-(iii),3-(iv),4-(i)

1-(ii),2-(iv),3-(i),4-(iii)

1-(iii),2-(ii),3-(i),4-(iv)
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Common data

Private or sensitive information

General information

Public information

1/1

Training

Identifying

Phishing

Sniffing

This content is neither created nor endorsed by Google. - Terms of Service - Privacy Policy

Does this form look suspicious? Report

Q50. Match the following Line chart   i) displays comparisons among
individual items   Stock chart  ii) displays continuous data over time   Bar
chart   iii) shows the relationship of parts to a whole, but it can contain
more                 than one data series  Doughnut chart  iv) displays the
fluctuation of stock prices निम्नहलिखित को मिलाए :

*

Q51. Once multiple accounts have been harvested , hackers can steal
________ for illegal monetary gain. विभिन्न खातों की हार्वेस्टिंग हो जाने के  बाद,
हैकर गैरकानूनी मौद्रिक लाभ के  लिए ..........चुरा सकते है।

*

Q52. The term authentication is used to describe the process of ______ a
person and making sure they are who they say they are ? प्रमाणीकरण
शब्दक का उपयोग किसी व्यीक्ति को .......... की प्रक्रिया का वर्णन करने और यह
सुनिश्चित करने के  लिए किया जाता हे कि वे वही है जो वे कहते है कि वे कौन है ।

*
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